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1. Introduction 

TRAIN TRACK
®
 Client/Server Edition is a client/server database application. It consists of a desktop user 

interface (client) and a database (server). All of your data is contained in a schema which is loaded onto a 
database application on your server. The user interface can be installed on individual workstations, and is 
linked to the server data through an Open Database Connectivity (ODBC) connection. The optional web 
component is a collection of Active Server Pages (.asp) stored on your web server which connect to the 
same database. 

 

 

 

 

 

 

 

 

   

 Figure 1 : Client/Server Concept 

1.1. Purpose 

This document provides instructions for installing a new copy of TRAIN TRACK Version 10. It 
may also be used to update your existing copy  

1.2. Installation Responsibility and Support 

This application should be installed on the customer’s network by an IT professional with the 
necessary skills and expertise to ensure proper configuration. It is the responsibility of the 
customer to install the application and adhere to any and all requirements for software 
configuration set forth by their own quality management system or other applicable regulations. 

Customers who are unable to install and configure the application on their own may purchase the 
installation package and Liberty Labs will install the software on their network for them. For 
customers who do not purchase the installation package, technical support is provided for the 
installation of the application; however, we cannot provide support for network connection issues 
or other issues outside of the TRAIN TRACK

®
 application. 
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1.3. Assumptions  

It is assumed that the customer will be installing the application on a secure computer network 
accessible by authorized users. It is assumed that the customer will have hardware in place to 
support the application, and that the customer has sufficient resources and procedures in place 
for network security and backup. It is assumed that the customer will have the ability to monitor 
and maintain the application after installation. 

1.4. System Requirements 

1.4.1. Network location for the SQL Server
®
 application and database that meets the 

requirements for the SQL Server
®
 version you plan to use.  

1.4.2. Network workstation(s) where you plan to install the client application for your users. 
Workstations may have the full version of Microsoft

®
 Access

®
 2010 already installed, or 

you may use the installer that includes the free runtime version of Microsoft
®
 Access

® 

2010. You need to have at least one copy of the full version of Microsoft
®
 Access

®
 2010 

to configure your ODBC connections if you do not use the default settings. 

1.5. Test Environment 

We recommend that the application be installed in a test environment prior to deployment. The 
application should be fully tested and validated before being released to users. If the customer 
does not have their own validation procedure in place, validation documents and test plans may 
be purchased separately. The validation documents may be incorporated into your own document 
control or other quality systems and edited as needed. 

1.6. Documentation 

A worksheet is included at the end of this document outlining each step of the installation 
procedure. This worksheet may be used to document your installation. 

2. Prerequisites 

These are the items that need to be in place before you can install TRAIN TRACK
®
.  

2.1. Identify Server 

Before installing TRAIN TRACK
®
 Client/Server, you need to install the SQL Server

®
 2008 or 

better that you will use for the back-end, or server, portion of the application. You can install the 
database on your local computer, or on a central server for access by multiple users. Identify the 
installation location. If you already have SQL Server

®
 installed, verify the location and skip the 

next step. 



Liberty Labs, LLC - TRAIN TRACK
® 

Software Installation Instruction Doc. #: SII-TT-002 Rev 06 

Author:  Sharon Moxon July 8, 2013 Page 8 of 32 

 

CONFIDENTIAL: THIS DOCUMENT CONTAINS CONFIDENTIAL AND PROPRIETARY INFORMATION. UNAUTHORIZED REVIEW, USE, OR DISTRIBUTION IS PROHIBITED. 

CONTROLLED: THIS IS A CONTROLLED DOCUMENT. THE OFFICIAL VERSION MUST BE VIEWED THROUGH THE DOCUMENT CONTROL INTERFACE ON THE LIBERTY 
LABS NETWORK. ALL OTHER COPIES, PRINTED OR ELECTRONIC, ARE UNCONTROLLED. 

2.2. Install SQL Server
®
 

Install the free version of SQL Server®, “SQL Express”, from the Microsoft
®
 website. Select the 

download option that includes SQL Server Management Studio. 

2.3. Load Setup Files 

Download and unzip the TRAIN TRACK
®
 installation files from the link that came with your 

registration code (this document was in the zip file, so you should already have it). Load the files 
to a folder on your network and identify this location. 

3. New Install or Update Existing Database? 

If you do not have an existing version of the program, then you will follow the New Installation 
instructions. If you have an existing standalone, or a client/server version 7 or 8, then you will need to 
follow the New Installation instructions, and the Import instructions. If you have an existing version 9 
database, then you will need to follow the Update instructions (See section 6Error! Reference 
source not found. below). 

 

Existing Edition Version Follow these Steps 

None  4.  New Installation Procedures 

Standalone  Version 7 - 10  4.  New Installation Procedures  

5.  Importing Data from a Previous Version 

Client/Server Version 7 - 8 4.  New Installation Procedures 

5.  Importing Data from a Previous Version 

Version 9 - 10 6.  Updating from a Previous Version 

Figure 2: New Install or Update Chart 

4. New Installation Procedures  

4.1. Back-up your Database 

If you have an existing standalone edition of TRAIN TRACK®, before you begin, please make a 
backup copy of your database by making a copy of the file and placing it in a safe location. 
Please be sure to test the backup to make sure it is usable and has all of your data. We 
recommend printing several reports from your existing database to use during the validation of 
the new database, such as the Status Summary report. 

4.2. Create the TRAIN TRACK® Server Database  

4.2.1. Open SQL Server
®
 Management Studio Express (or your existing version) 2008 or better. 

You will be prompted to connect to a server. Select the server, and make a note of the 
server name you connect to; you will need to enter it exactly the same way for your 
ODBC connection. 
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Figure 3: Connect to your SQL Server 

 
 

4.2.2. In the Object Explorer, right-click on Databases and select New Database. 
 
 

 

Figure 4: Create the database 

 
 

4.2.3. Type in the name “TRAINTRACK” for your database and click OK.  
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Figure 5: Name your new database 
 

4.3. Install the TRAIN TRACK
®
 Data Tables and Views 

Run the script that was provided with your setup files: 

4.3.1. From the SQL Server
®
 Management Studio menu bar, select File > Open > File. 

 

 

Figure 6: Open the SQL Script 
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4.3.2. A browse box will open. Browse to the location where you unzipped your TRAIN TRACK
®
 

installation files. Select TT10.x.x.sql and click Open. 

 

Figure 7: Open the script file 

 

4.3.3. TT10.x.x.sql will open.  

Note: if you named your database something other than “TRAINTRACK”, you will 
need to edit the first line of the script and insert the name of your database where 
it says USE [TRAINTRACK]. You must have at least one copy of the full version 
of Microsoft

®
 Access

®
 2010 if you do not use the default names. 

4.3.4. From the tool bar, click Execute. This will load the tables and views you need into your 
SQL database.  
 
 
 

 

Figure 8: Execute the SQL Script 

4.3.5. You should see a message stating that the query executed successfully. 
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Figure 9: SQL Script Executed Successfully 
 

4.4. Set up the database users  

To create secure connections for your authorized users, use Windows
®
 Authentication to connect 

to the SQL database through ODBC. 

4.4.1. From SQL Management Studio Express, expand the Security folder and right-click on 
the Logins folder.  

 

Figure 10: New login 

4.4.2. Select New Login. 

4.4.3. Now add the Windows
®
 group that contains the users of your TRAIN TRACK

®
 

application. If you do not have a Windows
®
 group, then you will have to add the users 

individually. 

4.4.4. In the Login – New window, under 'default database', select the TRAINTRACK database 
(using the name you assigned in step 4.2.3 above). 

4.4.5. Under User Mapping, check the TRAINTRACK database.  

4.4.6. Under Database Role Membership, check db_datareader and db_datawriter. Leave 
Public checked. This will give the users read and write access to the database.  

Note: If the user is the owner of the account, you will not need to assign these 
permissions because they already have full permissions for the database. 

If you used a Windows
®
 group, everyone in that group should be able to connect using 

Windows authentication. To add users later, just add them to the Windows
®
 group and 

set up the ODBC connection on their workstation. If you added users individually, you will 
need to add new users in the same way. 
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4.5. Identify Client 

Identify a workstation to use to install the client. You will set up the ODBC connection on this 
workstation.  

Note: you may use the server as your initial client installation location, or another network 
computer. 

If you are using a 64-bit operating system for your client, you will need to follow these steps; for 
32-bit, continue with step 4.6. 

4.5.1. From Windows Explorer, go to Windows\sysWOW64\odbcad32.exe and run. Set up your 
ODBC connection here, using the 32 bit driver, following the steps in item 4.6 below. If 
you don’t have this file, download and install the driver sqlncli_x64.msi from Microsoft. 

4.6. Set up the ODBC connection  

4.6.1. To set up the ODBC connection, go to the client computer.  

4.6.2. From Windows
®
 Control Panel, select  Administrative Tools > Data Sources (ODBC). 

4.6.3. Go to the User DSN tab and click Add. 

4.6.4. Select SQL Native Client (10 or higher) and click Finish.  

Note: the driver you use may differ depending on the version of SQL Server
®
 you 

have installed. 

 

Figure 11: ODBC Driver 

4.6.5. Type in the name TTSERV.  
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Figure 12: ODBC Data Source Name (DSN) 

4.6.6. Select your SQL Server
®
 (the same name you used when connecting through the SQL 

Management Studio in step 4.2.1 above) and click Next.  

Note: If it’s not on the list, type in the name of your server and your version of 
SQL Server. If you are using SQL Express, it should read 
“YourServer\SQLEXPRESS”. If you are using SQL 2008, it should read 
“YourServer\SQL2008”. 

4.6.7. Change the default database to TRAINTRACK, and click Next. 
 

 

Figure 13: Default Database 

4.6.8. Click Finish. 
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Figure 14: Finish 

4.6.9. Click Test Data Source.  
 
 

 

Figure 15: Test Data Source 

4.6.10. Click OK. 
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Figure 16: Test Completed Successfully 

4.6.11. Click OK. 
 
 

 

Figure 17: OK 

4.7. Install the TRAIN TRACK
®
 Client  

 

Note: If your database name or ODBC DSN is different than the default, the TRAIN TRACK® 
Client must be configured on a computer that has a full installation of Access

®
 2010, and then you 

may copy the Client onto machines with Access
®
 2010 Runtime. 

4.7.1. From the client computer, open Windows
®
 Explorer and browse to the location where you 

unzipped the TRAIN TRACK
®
 installation files.  

4.7.2. If you do not have Microsoft
®
 Access

®
 2010 installed and wish to install the free runtime 

version, locate the installation file TTCS_10_RTSetup.exe and double-click to open. 
Follow the instructions on your screen to install the client. 

4.7.3. If you already have the full version of Microsoft
®
 Access

®
 2010 installed, locate the 

installation file TTCS_10_Setup.exe and double-click to open.  
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4.7.4. Once installed, open the application. You should see the initial screen. You may select to 
import data from a previous version, enter a registration code, or start the 30-day trial. If 
you do not see the startup screen, open the linked table manager and re-link your data 
tables. 

5. Importing Data from a Previous Version 

If you need to import data from a previous version, please make sure you are importing from version 
7 or later. If you have an older version, you will need to update to version 7 before importing to 
version 10. 

If you are importing from another TRAIN TRACK® server database, please make sure each user 
interface (the old and the new) have distinct ODBC connection names, and that they are connected to 
the correct database. Make sure you have a valid, TESTED backup before you begin. 

5.1.1. To import data, open your new client application. If you do not see the startup screen, 
open the linked table manager and re-link your data tables. 

5.1.2. From the startup screen, click Import data from a previous version.  

Note: If you have already bypassed the startup screen, you can also import data 
by clicking “Import Data” from the navigation pane and then clicking “Import data 
from a previous version”. 

5.1.3. Click Browse and browse to the location of the user interface for your previous version. 

5.1.4. Click Import. Follow the instructions on your screen. You will see a message telling you 
that the data has been imported. 

6. Updating from a Previous Version 

If you are updating from version 9, then you will not need to install a new database. Instead, you will 
need to first back up your existing database, then run the script against your existing database. You 
may be able to use your existing ODBC connections, but you will need to run the linked table 
manager to re-link the data tables and views from within the new client. 

6.1. Back-up your Database 

If you have an existing client/server edition of TRAIN TRACK®, before you begin, please make a 
backup copy of your database.  

6.1.1. From SQL Management Studio Express (or your existing version), right-click on the 
database name and select Tasks > Backup. 
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Figure 18: Backup 
 

6.1.2. Click Add. 
 

 
 

Figure 19: Add Backup Destination 

6.1.3. Browse to the location you want to store your backup and click OK. 

6.1.4. Click OK in the backup dialog window. You will see a message that the backup was 
successful. 

6.2. Update the TRAIN TRACK
®
 Data Tables and Views 

Run the script that was provided with your setup files: 

6.2.1. From the SQL Server
®
 Management Studio menu bar, select File > Open > File. 
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Figure 20: Open the SQL Script 

 

6.2.2. A browse box will open. Browse to the location where you unzipped your TRAIN TRACK
®
 

installation files. Select TT10.x.x.sql and click Open. 

 

Figure 21: Open the script file 

 

6.2.3. TT10.x.x.sql will open.  

Note: if you named your database something other than “TRAINTRACK”, you will 
need to edit the first line of the script and insert the name of your database where 
it says USE [TRAINTRACK]. You must have at least one copy of the full version 
of Microsoft

®
 Access

®
 2010 if you do not use the default names. 

6.2.4. From the tool bar, click Execute. This will update the tables and views you need into your 
SQL database.  
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Figure 22: Execute the SQL Script 

6.2.5. You should see a message stating that the query executed successfully. 
 
 

 

Figure 23: SQL Script Executed Successfully 
 

6.3. Install the TRAIN TRACK
®
 Client  

 

Note: If your database name or ODBC DSN is different than the default, the TRAIN TRACK® 
Client must be configured on a computer that has a full installation of Access

®
 2010, and then you 

may copy the Client onto machines with Access
®
 2010 Runtime. 

6.3.1. From the client computer, open Windows
®
 Explorer and browse to the location where you 

unzipped the TRAIN TRACK
®
 installation files.  

6.3.2. If you do not have Microsoft
®
 Access

®
 2010 installed and wish to install the free runtime 

version, locate the installation file TTCS_10_RTSetup.exe and double-click to open. 
Follow the instructions on your screen to install the client. 

6.3.3. If you already have the full version of Microsoft
®
 Access

®
 2010 installed, locate the 

installation file TTCS_10_Setup.exe and double-click to open.  

6.3.4. Once installed, open the application. You should see the initial screen. You may select to 
enter a registration code, or start the 30-day trial. 

6.3.5. From the menu bar, click linked table manager. Click Select All and OK. 
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7. Web Component 

If you purchased a license for the optional web component, you are now ready to install it. 

The web-based interface is designed to work with the client/server application and run on your web 
server. Before installing the web components, the client/server application should already be in place. 
This includes both the SQL Server back-end database, and the Client user interface. The application 
should be fully tested and verified before proceeding with the web component installation. If the 
client/server application is already live, you may wish to use a test copy of the database for setting up 
and installing the web component prior to releasing the application to end-users. 

7.1. Prerequisites: 

Before beginning installation, you must have the following in place: 

7.1.1. TRAIN TRACK Client/Server, fully tested and verified. 

7.1.2. Classic ASP-enabled web server.  

The web server is not part of TRAIN TRACK
®
, and while we can’t support issues 

with your web server, we have provided some helpful information. You will need 
to be able to test your server and ensure that .asp pages are functional before 
you begin.  

ASP Web Server Tips: 

To run ASP pages, you need an application server that supports Microsoft Active 
Server Pages 2.0., such as Microsoft IIS (Internet Information Services), which 
comes with Windows but may need to be turned on. The following instructions 
are for configuring IIS. The process may be different depending on your 
operating system: 

 
A. Go to Control Panel > Programs and Features > Turn Windows features 

on or off. 
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B. Locate Internet Information Services > World Wide Web Services > 

Application Development Features and check the box for ASP. 

 
 

 

 
C. Next, go to Control Panel > Administrative Tools > Internet Information 

Services (IIS) Manager. 

 
D. Select Application Pools on the left, then click Add Application Pool on 

the right. 
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E. A box will open. Type in a descriptive name for your application pool and 

select the following settings, then click OK. 

 

 

 
F. If your operating system is 64 bit, then in the Internet Information 

Services (IIS) Manager, select the Application Pool, and set “Enable 32 

bit applications” to True; otherwise, skip to next step. 
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G. Next, in the Internet Information Services (IIS) Manager, select Sites on 

the left, and Add Web Site on the right. 

 

 
H. A box will open. Enter the information for your configuration and click 

OK. 
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I. In the Internet Information Services (IIS) Manager, select the site, and 

select Advanced Settings on the right. A box will open. Add asp to the list 

of Enabled Protocols. 

. 

 
J. Locate the root folder of your web server. 

The following are the default root folders of selected web servers: 

 

Optional: 

To test the web server, place a test ASP page using data from a database in the 
default root folder and attempt to open it by entering the page’s URL in a 
browser. The URL comprises the domain name and the filename of the ASP 
page, as follows: www.example.com/testpage.asp. 
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If the web server is running on your local computer, you can use localhost 
instead of a domain name. Enter one of the following localhost URLs to match 
your web server: 

 

If the page doesn’t open as expected, check for the following errors:  

• The web server is not started. Consult the web server’s 

documentation for starting instructions. 

• The file does not have an .asp or extension. 

• You entered the page’s file path (for example, 

c:\CFusionMX7\wwwroot\testpage.asp), not its URL (for example, 

http://localhost:8500/testpage.asp), in the browser’s address text 

box.  

• The URL contains a typing mistake. Check for errors and make 

sure the filename is not followed by a slash, such as 

http://localhost:8080/testpage.asp/. 

7.2. Database Access 

7.2.1. From SQL Management Studio, open the Security folder and right-click on the Logins 
folder.  

7.2.2. Select New Login. 

7.2.3. Now browse to the IUSR or IUSER account. This will be a built-in, existing account. 

7.2.4. In the Login - New window, under 'default database', select the TRAIN TRACK
®
 database 

(using the name you assigned in the step above). 

7.2.5. Under User Mapping, check the TRAIN TRACK
®
 database.  

7.2.6. Under Database Role Membership, check db_datareader and db_datawriter. Leave 
Public checked. This will give the users read and write access to the database.   

7.3. ODBC Connection 

Set up an ODBC connection on your web server following the same steps you used to set up the 
connection on your client workstation.  
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7.4. Install the Web Pages 

7.4.1. Create a new folder for the application inside the web server root folder. For example, 
using IIS, \Inetpub\wwwroot\TRAINTRACK\ 

7.4.2. Give the IUSR account access to this folder. 

7.4.3. Unzip the .asp files into this folder. 

7.4.4. Open your web browser and Browse to the location of the .asp files. For example: 
http://www.localhost/TRAINTRACK/adminsetup.asp  

7.4.5. Navigate to the page AdminSetup.asp. 

7.4.6. Click the “Add” button. 

7.4.7. From Login.asp, log in to the application using the name “Admin” and password “Admin”. 
Go to the user setup screen and edit the password for this user. 

7.4.8. Test the application. 

7.4.9. When satisfied with testing, delete the pages “AdminSetup.asp” and “UserCheck.asp”.  

 

8. Validation 

If you purchased the validation package, and plan to validate your installation of the application, 
please refer to the validation package documentation for further instructions. You may also create 
your own validation documents. 

We recommend at a minimum that you compare reports between your old version and the new one. 
Please note that you may see some differences in the total number for each status if you had 
scheduled training where the date for the class has passed but the training was not completed. In the 
previous versions, these would still be counted as “scheduled”, but in version 10 they revert to their 
previous state (i.e. needed or expired). If your totals are not the same, select several records at 
random and compare them in both versions. 
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Appendix 1:  Troubleshooting 

If you are unable to connect using ODBC: 

1. Make sure the SQL Server is running 

2. Stop and re-start your SQL Server if you have made any changes. 

3. Make sure the database is configured to allow remote connections, and both TP/IP and named 
pipes are enabled.  

a. Open SQL Server® > Configuration Tools. 

b. Under Services and Connections, click on remote connections, and select to allow both 
TCP/IP and named pipes. 

4. Make sure the database is set to allow both Windows and SQL authentication. 

5. Make sure the user is listed as a user in SQL Server®  

a. On your server, start SQL Server® Management Studio. 

b. Click Connect (top left) and connect to your server. 

c. From the tree at the left, select Security > Logins.  

d. Right-click and select New Login. 

e. Add the windows group that contains the users of your TRAIN TRACK® application. If 
you do not have an appropriate group, then you will have to add the users individually. 

f. In 'default database', select the database you want to have them automatically log into 
(this will be “TRAINTRACK” if you installed it using the default name). 

g. In user mapping, check the TRAIN TRACK® database. In database role membership, 
check db_datareader and db_datawriter. This will give them read and write access to that 
database.  

h. To set up the ODBC connection, go to the client computer and set it up using Windows 
authentication.  

6. If you are using a group for login permissions and it is not working, try creating a login for an 
individual user. 

7. Make sure you have correctly identified the server name in the ODBC connection. It should be 
the same as the server name you select when connecting to SQL Management Studio. 

8. Make sure your ODBC DSN is “TTSERV”. 

9. From Linked Table Manager, try creating a NEW ODBC connection, and over-writing the original 
one. 
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10. Make sure you have the correct ODBC driver. The recommended driver is the SQL Native Client 
10 or higher. 

11. Make sure the user has full permissions under your Windows security settings for the folder 
where the client database is stored. 

12. If you get an error “SQL State 08001 SQL Server Error 2 Could not open a connection to SQL 
Server (2)”, check your Windows firewall settings and make sure the application is not being 
blocked. 

13. Open a new Access database and attempt to link to and open the data tables with your ODBC 
connection. If this fails, then the problem is with your connection and not with the application.  

 

 

Setting up an initial web user 

14. If you are unable to log in, open the page usercheck.asp. This page will list all of the users that 
have been set up.  

15. If your user name is not included, open the page adminsetup.asp and click the link to set up an 
admin user. This will add a user to the database with user name “admin” and password “admin”.  

16. You may then log in under that name and edit your users. 

If you are unable to log in to the web component 

17. If you are unable to log in or view any pages that have data from the database, this is most likely 
caused by not having correct user permissions set up in the database. Make sure your Windows 
users are listed with datareader and datawriter permission, as well as your IUSR and the ttuser. 

Using a Connection String 

18. If you are unable to view any data, you can replace the ODBC connection with a connection 
string. To do this: 

19. Open the folder where you installed the web pages. 

20. Open the file Connections/TTSERV.asp. You can open it using Notepad or your web authoring 
tool. 

21. Replace the existing text with your connection string. Connection strings will vary depending on 
your configuration. Below are some example strings. 
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Make sure there is not a firewall blocking port 1433 or 1434. 
 
Check to see if you have an error log file located at c:/ProgramFiles/Microsoft SQL 
Server/MSSQLxx.xxx/MSSQL/Log. 
 
 
 

Example A: 
<% 

Dim MM_TTSERV_STRING 

Set MM_TTSERV_STRING = Server.CreateObject("ADODB.Connection") 

MM_TTSERV_STRING.Open "Provider=SQLOLEDB;Data Source=MYSERVER\MYSQL;" _ 

    & "Initial Catalog=traintrack2009;User Id=ttuser;Password=22user;" _ 

    & "Connect Timeout=15;Network Library=dbmssocn;" 

%> 

Substitute the name of your actual server and SQL instance for MYSERVER\MYSQL. If you don’t 
know what this is, open the SQL Management studio. A box will open asking you what database 
to connect to. This is what you need to use in the string. For example, for the server shown in the 
box below: 

 

 

The string would be: 
<% 

Dim MM_TTSERV_STRING 

Set MM_TTSERV_STRING = Server.CreateObject("ADODB.Connection") 

MM_TTSERV_STRING.Open "Provider=SQLOLEDB;Data Source=BESSIE\SQL2008;" _ 

    & "Initial Catalog=traintrack2009;User Id=ttuser;Password=22user;" _ 

    & "Connect Timeout=15;Network Library=dbmssocn;" 

%> 

 

Example B: 

<%  
Dim MM_TTSERV_STRING  



Liberty Labs, LLC - TRAIN TRACK
® 

Software Installation Instruction Doc. #: SII-TT-002 Rev 06 

Author:  Sharon Moxon July 8, 2013 Page 31 of 32 

 

CONFIDENTIAL: THIS DOCUMENT CONTAINS CONFIDENTIAL AND PROPRIETARY INFORMATION. UNAUTHORIZED REVIEW, USE, OR DISTRIBUTION IS PROHIBITED. 

CONTROLLED: THIS IS A CONTROLLED DOCUMENT. THE OFFICIAL VERSION MUST BE VIEWED THROUGH THE DOCUMENT CONTROL INTERFACE ON THE LIBERTY 
LABS NETWORK. ALL OTHER COPIES, PRINTED OR ELECTRONIC, ARE UNCONTROLLED. 

Set MM_TTSERV_STRING = Server.CreateObject("ADODB.Connection")  
MM_TTSERV_STRING.Connectionstring = "Provider = SQLOLEDB; Data Source = 
BESSIE\SQL2008; Initial Catalog = traintrack2009; User Id=ttuser; Password=22user"  
MM_TTSERV_STRING.Open  
%>  
 
 

Save the file, and test your web pages. 

 

Use SQL Authentication 

22. To connect using SQL authentication, add a user to the SQL database, set up the ODBC with 
SQL authentication, then add the user name and password to the connection file. 

 

If you are using Windows Server 2008 here is some information about setting up the basic web site: 

http://www.trainsignaltraining.com/windows-server-2008-iis7 

For support, please call 619-284-8013. Our office hours are 7 a.m. to 4 p.m. Pacific Time, but we can be 
available by appointment outside office hours. 
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Appendix 2:  Installation Worksheet 
 

# Item Identification/Documentation Completed By Date 

1. 2.1 Identify Server Server configuration, name, and location: 

 

  

2. 2.2 Install SQL 
Server 

Version: 

Instance: 

 

  

3. 2.3 Load Setup 
Files 

Setup file location: 

 

  

4. 4.2 Create 
Database 

Database name: 

 

  

5. 4.3 Install Tables 
and Views 

Name of script used: 

 

  

6. 4.4 Set up 
database user 

User name/password: 

 

  

7. 4.5 Identify Client Client configuration, name, and location: 

Access version: 

  

8. 4.6 Set up the 
ODBC Connection 

Connection name: 

 

  

9. 4.7 Install the 
Client 

 

Location: 

 

  

10. 7 Install the Web 
Component 

URL: 

 

  

Version Installed: _____________________ Installed By: __________________________________ 

Date Completed: _____________________ Signature: ____________________________________ 

Comments/Additional Notes: 


